Desktop Publishing II
Unit 5—Web Page Design
Learning Application 5.1
1. Load Publisher. 
2. In the New Publication task pane, under New From a Design: click on Web Sites and E-Mail.
3. Select the Accent Box Easy Web Site.

4. When asked “What do you want to do with your web site?” select the following:

a. Tell customers about my business

b. Display a calendar or schedule

c. Click OK.

5. For now, we’ll go ahead and save the file as a publication, so we can continue to work on it. Save the file as Ski Retreat in your DTP2 Unit 5—Web Page Design folder.

6. On the Home Page

a. For the logo:

1) Click the logo object in the upper right-hand corner of the home page.

2) Delete it.

3) Insert the FBLA.jpg graphic from your Files Needed folder in the DTP 2 Unit 5—Web Page Design Folder.

4) Place it where the logo used to be. Resize it if necessary.

b. For the Business Name:

1) Key PRHS Future Business Leaders of America
2) Replace the text Key your business tag here, with Sunset Mountain Ski Retreat
c. For the photo:

1) Delete the photo that is there.
2) Insert the FBLA Photo.jpg from your Files Needed folder in the DTP 2 Unit 5—Web Page Design Folder to take its place.
3) Resize appropriately, and move it to the correct location.
d. For the caption:

1) Erase the current text.
2) Key Some of our FBLAers having fun together.
e. For the Contact Us:

1) In the top box enter the following:

Doug Ingram

FBLA President

Pea Ridge High School

781 West Pickens Road

Pea Ridge, AR 72751

2) In the lower box enter the following:

Phone: 479-555-8182

Fax: 479-555-0323

E-mail: ingramd@prs.k12.ar.us

7. In the textbox that begins, “This is the first page . . .” key or copy and paste the following paragraph to replace the text. Make the text Arial 10 point.

The Pea Ridge High School Chapter of the Future Business Leaders of America is sponsoring a 4-day, 3-night ski retreat to Colorado. It is our intention not only to enjoy the thrilling outdoor activities, but to also develop a sense of camaraderie among our officers and members. We plan to develop our program of work for the coming year, and just get to know each others strengths so that we can better use them to help our chapter grow over the coming year.

8. On the page 2 rather than telling about us, we’re going to tell about Sunset Mountain.

a. For the logo:  Again you’ll need to change the logo to the FBLA graphic. In fact let’s just go ahead and do this on all pages now.

1) First, go to each page and delete the logo object.

2) Go back to the home page (page 1) and copy the FBLA logo.

3) Move to each page and paste. It should paste the logo in the same size and position as the one on the home page.

b. Replace the text About Us with Sunset Mountain
c. Replace it on both of the navigation bars also.

d. In place of the paragraphs, key the following: (NOTE: You can copy it from here and paste it there, but make sure you end up with the same typeface and size as the text you are replacing.

Located in the beautiful Colorado Rockies, Sunset Mountain’s extreme elevation allows it to boast the latest ski season in Colorado and one of the longest ski runs at more than a mile!
Sunset Mountain offers a wide variety of winter sports, including downhill and cross-country skiing, as well as tubing, and bob-sledding runs, Downhill slopes for beginner, intermediate, and advanced skiers are groomed daily. Experienced ski instructors conduct small group lessons.

If skiing isn’t your “thing” think variety! Sunset Mountain is offering an advanced tubing course this season, with banked turns and jumps to make your trip down the mountain more exciting.
Sunset Mountain is off the beaten path, so lifts are not crowded. Four double-chair lifts accommodate 1,000 people per hour, so you never have a long wait to begin your skiing adventure. Whether you are into bunny slopes or telemark skiing, you will love Sunset Mountain.

e. For the picture:

1) Delete the current picture.

2) Insert the Sunset Mountain.jpg graphic from your Files Needed folder in the DTP 2 Unit 5—Web Page Design Folder to take its place.
3) Resize appropriately, and move it to the correct location.
f. For the caption:

1) Erase the current text.
2) Key Sunset Mountaintop.

9. For page 3

a. For the Calendar:

1) Click on the calendar to make it active, then click the calendar wizard button.

2) At the bottom of the Calendar designs pane, click the Change calendar range button.

3) Make it March of next year.

4) Select the cells with the dates 19 through 22, and fill them with blue. These are the dates of the trip.

b. For the Schedule of Activities:

1) Delete the boxes that read, “More Details”.
2) Enter the following information in the four remaining text boxes. Each paragraph goes in a separate box. Don’t worry about how well it fits. You’ll take care of that in the next instruction.
March 19—Arrive and unpack. Lunch will be on your own. Those who signed up for a ski lesson will meet in the lodge lobby at 1:00 p.m. All others are free to participate in the indoor and/or outdoor activities provided by the resort.  We will dine together at the Mountain Inn Dining Room at 6:00 p.m. After dinner we will meet in the lodge conference room and enjoy boundary breaking in front of the huge fireplace.

March 20—After breakfast, you may participate in the oudoor or indoor activities provided at the resort. Lunch is on your own.  In the afternoon, you can again participate in the outdoor and indoor activities. At 6:00 p.m. we will dine together, then in the evening we will meet again in front of the fireplace, to work on our Program of Work for the coming year.

March 21—After breakfast, you may participate in the outdoor or indoor activities provided at the resort. Lunch is on your own.  In the afternoon, you can again participate in the outdoor and indoor activities. At 6:00 p.m. we will dine together. After dinner we will gather for the last time in front of the fireplace, to finish up our Program of Work for the coming year, and to share our thoughts about this retreat experience.

March 22—Everyone will meet for breakfast at 7 a.m. At that time you should have everything packed and brought to the lobby of the lodge. After breakfast, we will board the airport shuttle back to the airport and return home.

3) Vertically resize the boxes so that:

a) All the text fits in the box

b) All the text is in Arial 10 point

c) The boxes are distributed evenly with about 1/8 of an inch of blank space between them. NOTE: You will probably have to move the navigation bar down some on the page to make room.

4) Move the two To contact us: boxes down so that they are just above the horizontal navigation bar.

10. To add a fourth page with a form:

a. To create the page:

1) Open the Format menu and click on Web Page Options.

2) Under Add to your Web site on the Web Page Options pane, select Insert a Page.

3) When the Insert Web Page dialog box appears, click on Forms then choose Sign-up Form.

4) Click OK.

b. Change the logo.

c. Delete the text box under Sign Up Form that begins with “Register customers for an …”
d. Enter FBLA Ski Retreat March 19–22 as the Sign up form title.
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Delete all the Time boxes.

f. You will have to move everything from the Subtotal box down, down so that the top of the Subtotal box is at about the 5” mark on the vertical ruler.

g. You’ll need to copy two of the lines and paste them below the others because you’ll need six event lines.

h. Enter the information as shown in the screen shot to the right. NOTE: You cannot copy and paste the screen shot—it won’t work when I view your web page.

11. Preview your web page:

a. If the Web Page Options Pane is not already open, open the Format menu and click on Web Page Options.

b. Under Add to your Web site on the Web Page Options pane, select Preview your web site.

c. Test your links. See if anything looks unbalanced or off, so you can fix it.

d. Close the Internet Explorer window to return to Publisher.

e. Make any changes needed, and preview again if necessary.

12. Save as a web site
a. Save the file as it is first.

b. Open the File menu and click on Publish to the Web.

c. Navigate to your folder.
d. In your DTP2 Unit 5—Web Page Design make a folder named Assignment 5-1.

e. Save your Web site in this folder. Leave the filename as it is—Index.htm. All home pages of a Web site must have that name.
13. Don’t forget to check off Assignment 5-1 on the door so Mrs. Cotton can grade it.

Learning Application 5.2
Lisa Sizemore, Catering Director at the Pea Ridge Country Club’s Hawk’s Nest Restaurant, has asked you to create a web site for The Rose Garden Catering Service. 
1. Load Publisher. 

2. In the New Publication task pane, under New From a Design: click on Web Sites and E-Mail.

3. Select the Marquee Easy Web Site.

4. When asked “What do you want to do with your web site?” select the following, for now let’s just select Tell customers about my business. We’ll add more later.

5. For now, we’ll go ahead and save the file as a publication, so we can continue to work on it. Save the file as Catering in your DTP2 Unit 5—Web Page Design folder.

6. Make some overall changes to the site:

a. Change the color scheme to burgundy.

b. Select the Virtual Font Scheme

c. Make the Navigation Bar Vertical only.
7. On the Home Page

a. Enter The Rose Garden Catering Service in place of the Business Name.

b. Make it 14 point bold.

c. On the next line key The Hawk’s Nest Restaurant followed by an inserted filled circle symbol followed by Pea Ridge Country Club. It should look similar to the line below.

The Hawk’s Nest Restaurant  Pea Ridge Country Club

d. Delete the Logo object, and insert the Rose Logo.gif file from your Files Needed folder in the DTP 2 Unit 5—Web Page Design folder. Resize it to 30% and move it to the appropriate place.

e. In the text box that begins “This is the first page of your …”, key or copy the following text.
The Rose Garden Catering Service is provided by The Hawk’s Nest Restaurant which is an integral part of the Pea Ridge Country Club. 

Whether you are hosting a family reunion, birthday celebration or a conference, The Rose Garden’s experienced Catering Services Department can assist in making each event memorable. They will help detail menus, decorations, flowers and entertainment. Additionally, The Rose Garden offers a wonderful choice of venues, from the 2400 square foot ballroom which opens to a 1200 square foot deck to the Rose Garden with it’s beautiful outdoor charm. If you prefer, our staff will work with you on an off-site location for your event. 

f. If necessary, change the font of the text you just entered to Trebuchet MS 12 point.
g. Delete the clip art. Insert the Rose Garden photo from your Files Needed folder in the DTP 2 Unit 5—Web Page Design folder. Resize it to 150% and move it to the appropriate place.

h. Change the caption to read, “We can satisfy all your catering needs.”
i. Scroll down to the To contact us text boxes. In the Primary Business Address text box, enter or copy and paste the following information. Resize the textbox if necessary. Make the text Trebuchet MS 12 point.
The Hawk’s Nest Restaurant

Pea Ridge Country Club

325 Snob Drive

Pea Ridge, AR 72751
j. Key or copy and paste the following information in the phone number text box. Resize the textbox if necessary. Make the text Trebuchet MS 12 point.
Lisa Sizemore, Catering Director

Phone: 479-555-5486

Fax: 479-555-4568

Email: lsizemore@prcc.com
k. Notice the navigation buttons to the left. Change the second one so that rather than reading “About Us”, it reads, “Policies & Procedures”. 
8. On the Second Page

a. Change the size of the font for The Rose Garden Catering Service to 14 point.

b. Delete the logo in the upper left-hand corner, then copy and paste the logo from page 1.

c. Change the text in the “About Us” textbox to “Policies & Procedures”.

d. For the textbox that begins with “Tell customers about your . . .”

1) Delete the tree clip art and the caption beneath it. 

2) Resize the textbox to use this area. Be sure to leave a small space between the edge of the textbox and the edge of the page. Use the textbox above it as a guide.

3) In your Files Needed folder you’ll find a Word document named Policies Text. Open that file in Word then you can copy the text, and paste it into the textbox 

4) Make the text Trebuchet MS 10 point.

9. To add a third page with a response form:

a. To create the page:

1) Open the Format menu and click on Web Page Options if necessary.

2) Under Add to your Web site on the Web Page Options pane, select Insert a Page.

3) When the Insert Web Page dialog box appears, click on Forms then choose Response Form.

4) Click OK.

b. You may notice that the fonts don’t match up on the new page. Reapply the Virtual Font Scheme.

c. Change the size of the font for The Rose Garden Catering Service to 14 point.

d. Delete the logo in the upper left-hand corner, then copy and paste the logo from page 1.

e. Change the text in the “Response Form” textbox to “Ice Cream Social”.

f. Change the third button on the vertical navigation bar from “Form” to “Ice Cream Social”

g. Delete the textbox that begins, “Ask readers to . . .”

h. In place of the text “Reponse form title” key “$2.95 per person”. Center the text in the textbox.

i. In the textbox that begins, “Type a description . . . “ key, “Vanilla, Chocolate, and Strawberry ice cream are included.” Make the text 9 points, italic, and center it.
j. Delete the textboxes labeled “Question 3” and “Question 4”
k. In the Question 1 texbox, key “Choose four of the following toppings.” Make the text 10 point bold and resize the textbox so that the text is all on one line.

l. In the Question 2 texbox, key “Additional Topping Options” Make the text 10 point bold and resize the textbox so that the text is all on one line.
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Using the screenshot to the right as a guide, make the needed entries and adjustments to the form. Here are a few helpful hints: 
1) Move the entire section up some, so that the textbox with $2.95 per person is about 1/4-inch below the horizontal line. 

2) Take the top two selection boxes from the bottom section and put them with the top section. 
3) In order to get the second lines in the additional topping options you’ll need to hold down Shift when you tap the Enter key for the second line, and you’ll also need to resize the boxes slightly. 

4) Copying and pasting the screenshot into your document won’t work. These are controls and they won’t work properly if it’s just a picture. Plus that’s cheating and will result in a grade of zero and a day of detention.

n. The bottom section needs to be quite a bit different than the defaults that were placed there. Most of the controls we need are similar to the one set up for the phone. So we’ll just copy that one for some. Follow the instructions below to create this section.

1) Copy the black horizontal line near the top and paste it below the last entry from instruction m above. This will separate the sections of the page.

2) Delete the address textbox, and control.

3) Move the Phone and Email textboxes and controls to the top of the section and move the Comments textbox and control to the bottom, where Phone and Email were.

4) In the textbox with the word Phone, key Name of organization requesting catering services:  You’ll have to move the control over the right and resize the textbox so that all the text is visible. It should look something like the screenshot below:

5) In the textbox with the word Email, key Contact Person:  If necessary, move the control over the right and resize the textbox so that all the text is visible. 

6) Copy and paste either of the two, to make a new line for the Phone: 

7) Continue to copy/paste and make adjustments until you have the following textboxes and controls. Be sure to use good desktop publishing techniques: line them up, distribute them evenly, etc.
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8) We also need to add a check box control which wasn’t among the defaults added to the page. 
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First we need to copy one of the textboxes so we have a place to put our question. Copy the largest one and place it where the next textbox would go.
b. In the textbox key Will the event be held at the Rose Garden?
c. Adjust the size to fit the text.

d. On the objects toolbar, click the Form Control button. [image: image2.jpg]



e. Choose Checkbox from the drop down menu. 

f. Move it to the right of the question. Enter Yes in the textbox that goes with the checkbox. Copy and paste another one, and enter No in the new textbox. You may have to reapply the font scheme so they will match the others. The line should look like this:
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g. Finally, enter text and make the adjustments to the last question. Your finished section should look like this:
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10. Save as a web site

a. Save the file as a publication as usual first.

b. Open the Format menu and click on Publish to the Web.

c. Navigate to your folder.

d. In your DTP2 Unit 5—Web Page Design make a folder named Assignment 5-2.

e. Save your Web site in this folder. Leave the filename as it is—Index.htm. Remember, all Web site home pages must have that name.

11. Don’t forget to check off Assignment 5-2 on the door so Mrs. Cotton can grade it.

Challenge Application 5.3
A friend of yours is opening up a day spa and they want you to design a web site for them.


1.
Start Use the design style you think would best project a feeling of relaxation. Keep in mind that you can change the color scheme. You can also select a Font scheme that you feel is appropriate.

2.
Obtain a brochure from Mrs. Cotton to create your web site. You must include all the information from the brochure in your site. In your Files Needed folder you’ll find some pictures to use in your web site.
1. As you work, save with Pamper Me as the filename in your DTP2 Unit 5—Web Page Design folder.

2. When you’ve finished, create a folder in your DTP2 Unit 5—Web Page Design named Assignment 5-3. Save your Web site as a Web page in that folder.

3. Don’t forget to check off Assignment 5-3 on the door so Mrs. Cotton can grade it.

Challenge Application 5.4
In this application you will create your own personal Web site.

1.
You may use any style from the Web Site Builder that you want. This will give you a theme.

2.
The home page should include (minimum): 
· A masthead that includes your name (Use your first name only, please.)

· A paragraph about yourself.

· A picture of yourself (you can use the digital camera or scanner)

· At least one clip art

· Fill in the appropriate contact information at the bottom of the web page, but make it up—don’t use your real information.


3.
The second page should be a My Favorite Links page. On this page you must include (minimum): 

· At least 6 links with the site name and address plus a brief summary or description of the site. (These MUST be appropriate web sites for school. If you have any doubt whatsoever that Mrs. Cotton would not approve of the site, DON’T USE IT!)
· At least three graphics. At least one should be an animation. At least one should be a banner. 


4.
Be sure you check that you have been consistent in your formatting from page to page.

5.
As you work, save with your name as the filename in your DTP2 Unit 5—Web Page Design folder.


6.
When you’ve finished, create a folder in your DTP2 Unit 5—Web Page Design folder named Assignment 5-4. Save your Web site as a Web page in that folder.


7.
Don’t forget to check off Assignment 5-4 on the door so Mrs. Cotton can grade it.


Challenge Application 5.5

In this application you will evaluate three web sites. 

1.
Choose a topic and get it approved by Mrs. Cotton. It should be something appropriate for school such as a topic for a research paper for another class. 


2.
Use a search engine to find three web sites containing information about the approved topic.


3.
Print  3 Web Site Evaluation Forms. You’ll find the form in a word document in your DTP2 Unit 5—Web Page Design folder. Go to the web sites one at a time. For each web site, record the information at the top of the form, and complete the evaluation. Turn all three forms in to be graded.
Desktop Publishing II Unit 5—Web Page Design
4

